SolidWorks® 2015 Reference Guide
A comprehensive reference guide with over 240 standalone tutorials

David C. Planchard, CSWP, SolidWorks Accredited Educator

Multimedia Disc
Includes Supplemental Files and Video Instruction

Better Textbooks. Lower Prices.
www.SDCpublications.com
Visit the following websites to learn more about this book:
CHAPTER 4: DESIGN INTENT, SKETCHING AND SKETCH ENTITIES

Chapter Objective

Chapter 4 provides a comprehensive understanding of Design Intent, Sketching and the available Sketch Entities in SolidWorks. On the completion of this chapter, you will be able to:

- Define and incorporate Design Intent in a:
  - Sketch, Feature, Part, Assembly and Drawing document.
- Utilize the available SolidWorks Design Intent tools:
  - Comments, Design Binder, ConfigurationManager, dimensions, equations, design tables and features.
- Identify the correct Reference planes:
  - 2D and 3D Sketching.
- Insert sketch Reference planes.
- Comprehend the Parent/Child relationship.
- Recognize and address Sketch states:
- Identify and utilize the following Sketch Entities tools:
  - Line, Corner Rectangle, Center Rectangle, 3 Point Corner Rectangle, 3 Point Center Rectangle, Parallelogram, Straight Slot, Centerpoint Straight Slot, 3 Point Arc Slot, Centerpoint Arc Slot, Instant3D, Polygon, Circle, Perimeter Circle, Centerpoint Arc, Tangent Arc, 3 Point Arc, Ellipse, Partial Ellipse, Parabola, Conic, Spline, Style Spline, Spline on Surface, Equation Driven Curve, Point, Centerline, Text, Plane, Route line and Belt/Chain.
- Classify and utilize the following Block tools:
  - Make Block, Edit Block, Insert Block, Add/Remove, Rebuild, Saves Block, Explode Block and Belt/Chain.
- Recognize and utilize the following Spline tools:
• Add Tangency Control, Add Curvature Control, Insert Spline Point, Simplify Spline, Fit Spline, Show Spline Handle, Show Inflection points, Show Minimum Radius and Show Curvature Combs.

• Reuse an existing 2D Sketch.

Design Intent

What is design intent? All designs are created for a purpose. Design intent is the intellectual arrangements of features and dimensions of a design. Design intent governs the relationship between sketches in a feature, features in a part and parts in an assembly.

The SolidWorks definition of design intent is the process in which the model is developed to accept future modifications. Models behave differently when design changes occur.

Design for change. Utilize geometry for symmetry, reuse common features, and reuse common parts. Build change into the following areas that you create: sketch, feature, part, assembly and drawing.

💡 When editing or repairing geometric relations, it is considered best practice to edit the relation vs. deleting it.

Design Intent in a Sketch

Build design intent in a sketch as the profile is created. A profile is determined from the Sketch Entities. Example: Rectangle, Circle, Arc, Point, Slot etc. Apply symmetry into a profile through a sketch centerline, mirror entity and position about the reference planes and Origin. Always know the location of the Origin in the sketch.

Build design intent as you sketch with automatic Geometric relations. Document the decisions made during the up-front design process. This is very valuable when you modify the design later.

A rectangle (Center Rectangle Sketch tool) contains Horizontal, Vertical and Perpendicular automatic Geometric relations. Apply design intent using added Geometric relations if needed. Example: Horizontal, Vertical, Collinear, Perpendicular, Parallel, Equal etc.
Example A: Apply design intent to create a square profile. Sketch a rectangle. Apply the Center Rectangle Sketch tool. Note: No construction reference centerline or Midpoint relation is required with the Center Rectangle tool. Insert dimensions to fully define the sketch.

Example B: If you have a hole in a part that must always be $16.5\text{mm} \leq$ from an edge, dimension to the edge rather than to another point on the sketch. As the part size is modified, the hole location remains $16.5\text{mm} \leq$ from the edge as illustrated.

**Design Intent in a Feature**

Build design intent into a feature by addressing End Conditions (Blind, Through All, Up to Next, Up to Vertex, Up to Surface, Offset from Surface, Up to Body and Mid Plane), symmetry, feature selection, and the order of feature creation.

Example A: The Extruded Base feature remains symmetric about the Front Plane. Utilize the Mid Plane End Condition option in Direction 1. Modify the depth, and the feature remains symmetric about the Front Plane.

Example B: Create 34 teeth in the model. Do you create each tooth separately using the Extruded Cut feature? No. Create a single tooth and then apply the Circular Pattern feature. Modify the Circular Pattern from 32 to 24 teeth.

**Design Intent in a Part**

Utilize symmetry, feature order and reusing common features to build design intent into a part. Example A: Feature order. Is the entire part symmetric? Feature order affects the part.

Apply the Shell feature before the Fillet feature and the inside corners remain perpendicular.
Design Intent in an Assembly

Utilizing symmetry, reusing common parts and using the Mate relation between parts builds the design intent into an assembly.

Example A: Reuse geometry in an assembly. The assembly contains a linear pattern of holes. Insert one screw into the first hole. Utilize the Component Pattern feature to copy the machine screw to the other holes.

Design Intent in a Drawing

Utilize dimensions, tolerance and notes in parts and assemblies to build the design intent into a drawing.

Example A: Tolerance and material in the drawing. Insert an inside diameter tolerance +.000/-.002 into the Pipe part. The tolerance propagates to the drawing.

Define the Custom Property Material in the Part. The Material Custom Property propagates to your drawing.

💡 Create a sketch on any of the default planes: Front, Top, Right or a created plane or face.

SolidWorks Design Intent tools

Comments

Add comments, notes or additional information to features or sketches during the design period. This will aid you or your colleagues to recall and to better understand the fundamental design intent later of the model and individual features.

Right-click on the name, feature or sketch in the FeatureManager. Click Comment ➤ Add Comment. The Comment dialog box is displayed.
Enter the information. Click Save and Close. A Comments folder is displayed in the FeatureManager. Double-click the feature in the Comments folder to view the comment.

💡 You can also add a Date/Time stamp to your comment.

**Design Binder**

Activate the Design binder. Click Options ➔ System Options tab ➔ FeatureManager. Select Show from the drop-down menu. The Design Binder is an embedded Microsoft Word document that provides the ability for the user to capture a screen image and to incorporate text into a document.

**ConfigurationManager**

When you create various configurations for assemblies, design tables, etc. Use the comment area to incorporate a comment for these configurations.

**Dimensions**

To be efficient, reuse existing geometry. Provide dimensions with descriptive names.

**Equations**

SolidWorks provides a completely redesigned dialog box for creating and editing equations, global variables and dimensions. Add a comment to the end of an equation to provide clarity for the future. Use descriptive names and organize your equations to improve clarity.
You can specify the units of measurement for global variables, and for the values and equations that define the global variables. You can define the units in the Equations and modify dialog boxes for dimensions, and in PropertyManagers that support equations.

**Design Tables**

There are a number of ways to incorporate a comment into a design table. One way is to add \$COMMENT\” to the heading of a column. This provides the ability to add a comment in a design table.

**Features**

Always use descriptive names in the FeatureManager design tree, not the default feature names such as Boss-Extrude1, Cut-Extrude1, LPattern1, etc. Group important features toward the top of the FeatureManager design tree.

   ![FeatureManager Name feature on creation option](image)

Enable the FeatureManager Name feature on creation option, click Options ➜ System Options ➜ FeatureManager ➜ Name feature on creation box. The Name feature on creation option highlights the feature name when created and allows the feature to be named.

**Identify the Correct Reference Planes**

Most SolidWorks features start with a 2D sketch. Sketches are the foundation for creating features. SolidWorks provides the ability to create either 2D or 3D sketches.

A 2D sketch is limited to a flat 2D Sketch Plane located on a Reference Plane, face or a created place. 3D sketches are very useful in creating sketch geometry that does not lie on an existing or easily defined Plane.

Does it matter where you start sketching? Yes. When you create a new part or assembly, the three default planes are aligned with specific views. The plane you select for your first sketch determines the orientation of the part. Selecting the correct plane to start your model is very important.
2D Sketching/Reference Planes

The three default \( \perp \) reference planes, displayed in the FeatureManager design tree represent infinite 2D planes in 3D space. They are:

- Front.
- Top.
- Right.

Planes have no thickness or mass. Orthographic projection is the process of projecting views onto parallel planes with \( \perp \) projectors. The default \( \perp \) datum planes are:

- Primary.
- Secondary.
- Tertiary.

Use the following planes in a manufacturing environment:

- Primary datum plane: Contacts the part at a minimum of three points.
- Secondary datum plane: Contacts the part at a minimum of two points.
- Tertiary datum plane: Contacts the part at a minimum of one point.

The part view orientation depends on the sketch plane. Compare the Front, Top and Right Sketch planes for an L-shaped profile in the following illustration. Remember - the plane or face you select for the base sketch determines the orientation of the part.
The six principle views of Orthographic projection listed in the ASME Y14.3 2009 standard are: Front, Top, Right, Bottom, Rear and Left. SolidWorks Standard view names correspond to these Orthographic projection view names.

<table>
<thead>
<tr>
<th>ASME Y14.3 2009 Principle View Name:</th>
<th>SolidWorks Standard View:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Front</td>
<td>Front</td>
</tr>
<tr>
<td>Top</td>
<td>Top</td>
</tr>
<tr>
<td>Right side</td>
<td>Right</td>
</tr>
<tr>
<td>Bottom</td>
<td>Bottom</td>
</tr>
<tr>
<td>Rear</td>
<td>Back</td>
</tr>
<tr>
<td>Left side</td>
<td>Left</td>
</tr>
</tbody>
</table>

ANSI is the default overall drafting standard used in the book.

Displayed are the Front, Top, Right and Isometric views in Third Angle Projection.

**Tutorial: Default Reference Planes 4-1**

Create a New part. Display the default Reference planes in the Graphics window.

1. Click **New** from the Menu bar. The Templates tab is the default tab. Part is the default template from the New SolidWorks Document dialog box.

2. Click **OK**. The Part FeatureManager is displayed. Use the sketch Origin to understand the (x,-y-) coordinate location of the sketch and to apply sketch dimensions. Each sketch in the part has its own Origin.

3. Click **Front Plane** from the FeatureManager design tree. The Front Plane is the Sketch plane. The Front Plane is highlighted in the FeatureManager and in the Graphics window.

Show the default Reference planes in the Graphics window. Select the Front, Top and Right planes.

4. Hold the **Ctrl** key down.

5. Click **Top Plane** and **Right Plane** from the FeatureManager design tree.
6. Release the Ctrl key.

7. Right-click Show from the Context toolbar. If needed click View, check Planes from the Menu bar.

8. Click inside the Graphics window. The three planes are displayed in the Graphics window. Note the Plane icon in the FeatureManager.

💡 Rename a feature or sketch for clarity. Slowly click the feature or sketch name twice and enter the new name when the old one is highlighted.

Rename the default Reference planes.

9. Rename the Front Plane to Front-PlateA.

10. Rename the Top Plane to Top-PlateB.

11. Rename the Right Plane to Right-PlateC.

12. Rebuild the model.

13. Close the model.

---

**3D Sketching/Reference Planes**

Create a 3D Sketch in SolidWorks. A 3D Sketch is typically used for advanced features such as Sweeps and Lofts or when the sketch does not lie on an existing or easily definable plane. Most basic features are created from a 2D Sketch.

There are two approaches to 3D Sketching. The first approach is called 2D Sketching with 3D Sketch planes. In this approach, you:

1. Activate a planar face by adding a 3D Sketch plane.

2. Sketch in 2D along the plane.

3. Add 3D Sketch planes each time you are required to move sketch entities to create a 3D sketch.

Using the 2D Sketching with 3D Sketch planes approach provides the ability to:

- Add relations:
  - Between planes.
  - Between sketch entities on different planes.
  - To planes.
  - Define planes.
  - Move and resize planes.
**Tutorial: 3D Sketching 4-1**
Create a simple 2D Sketch using 3D Sketch planes.

1. Create a New part. Use the default ANSI Part template.
2. Click Top Plane from the FeatureManager.
3. Click 3D Sketch On Plane from the Sketch Consolidated toolbar as illustrated. 3DSketch1 is active.
4. Click the Line Sketch tool.
5. Sketch a vertical line through the Origin.
6. Right-click Exit Sketch from the Context toolbar. 3DSketch1 is displayed in the FeatureManager and is under defined.
7. Close the model.

**Tutorial: 3D Sketching 4-2**
Create the illustrated model. Insert two features: Boss-Extrude1 and Cut-Extrude1. Apply the 3D Sketch tool to create the Cut-Extrude1 feature. System units = MMGS.

1. Create a New part in SolidWorks. Use the default ANSI, MMGS Part template.
2. Right-click Front Plane from the FeatureManager. This is your Sketch plane.
3. Click Sketch from the Context toolbar. The Sketch toolbar is displayed.
4. Click the Corner Rectangle tool from the Consolidated Rectangle Sketch toolbar. The PropertyManager is displayed.
5. Sketch a rectangle as illustrated. The part Origin is located in the bottom left corner of the sketch. Insert dimensions.
6. Right-click Smart Dimension from the Context toolbar.
7. Dimension the sketch as illustrated. The sketch is fully defined. The sketch is displayed in black.
Create the first feature for the model. The Extruded Boss/Base feature adds material to a part. Extrude the sketch to create the first feature. Apply symmetry.

8. Click **Extruded Boss/Base** from the Features toolbar.

9. Select the **Mid Plane** End Condition in Direction 1. Enter **100.00** mm for Depth in Direction 1. Accept the default conditions. Click **OK** from the Boss-Extrude PropertyManager.

The Instant3D tool provides the ability to drag geometry and dimension manipulator points to resize features or to create new features directly in the Graphics window. Click the face. Select a manipulator point. Click and drag. Click a location along the ruler for the required dimension. The rule increments are set in System Options.

10. Create 3DSketch1. 3DSketch1 is a four point sketch. Click **3D Sketch On Plane** from the Consolidated Sketch toolbar as illustrated.

11. Click the **Line** Sketch tool. 3DSketch1 is a four point sketch as illustrated. 3DSketch1 is the profile for Cut-Extrude1.

12. Locate the first point of the sketch. Click the **back right bottom point** as illustrated. Locate the second point of the sketch. Click the **top left front point** as illustrated. Locate the third point of the sketch.

13. Click the **bottom right front point** as illustrated.

14. Click the **back right bottom** point as illustrated to close the sketch.

Create the Cut-Extrude1 feature.

15. Click **Extruded Cut** from the Features toolbar.
16. Click the **front right vertical edge** as illustrated to remove the material. Edge<1> is displayed in the Direction of Extrusions box.

17. Click **OK** from the Cut-Extrude PropertyManager. Cut-Extrude1 is displayed in the FeatureManager. **Close** the model.

Select the front right vertical edge or the Top face to remove the required material in this tutorial.

Use any of the following tools to create 3D Sketches: Lines, All Circle tools, All Rectangle tools, All Arcs tools, Splines and Points.

The second approach to create a 3D Sketch in SolidWorks is 3D Sketching. In this approach:

1. Open an existing 3D Sketch.
2. Press the Tab key each time you need to move your sketch entities to a different axis.

The sketch origin is placed wherever you start the sketch.

**Tutorial: 3D Sketching 4-3**

Apply the 3DSketch tool to create a 3DSketch using the Tab key to change Sketch planes.

1. Open **3D Sketching 4-3** from the SolidWorks 2015 folder.

   Edit the 3D Sketch.

2. Right-click **3DSketch** from the FeatureManager.

3. Click **Edit Sketch** from the Context toolbar. 3DSketch1 is displayed in the Graphics window.

4. Click the **Line** Sketch tool. Note: The mouse feedback icon.

5. Click the **right endpoint** of the sketch as illustrated.

6. Press the **Tab** key to change the Sketch plane from XY to YZ. The YZ icon is displayed on the mouse pointer.

7. Sketch a **line** along the Z axis approximately 130mm as illustrated.

8. Press the **Tab** key twice to change the sketch plane from YZ to XY. The XY icon is displayed on the mouse pointer.
9. Sketch a line back along the X axis approximately 30mm.
10. Sketch a line on the Y axis approximately 30mm.
11. Sketch a line along the X axis of approximately 130mm.

Deselect the Line Sketch tool.
12. Right-click Select. View the 3D Sketch.
13. Rebuild the model.
14. Close the model.

**Tutorial: 3D Sketching 4-4**

Utilize the 3D Sketch placement method. Insert a hole on a cylindrical face using the Hole Wizard.

1. Open 3D Sketching 4-4 from the SolidWorks 2015 folder. Note: With a 3D sketch, press the Tab key to move between planes.
2. Click the Hole Wizard feature tool.
3. Create a Counterbore, ANSI Inch, Socket Head Cap Screw fastener Type. Size - ¼. Fit - Normal. End Condition - Through All with a .100in Head clearance.
4. Click the Positions Tab.
5. Click the 3D Sketch button. The Hole Position PropertyManager is displayed. SolidWorks displays an active 3D interface with the Point tool.

💡 When the Point tool is active, wherever you click, you will create a point.

Dimension the sketch.
6. Click the cylindrical face of the model as illustrated. The selected face is displayed in orange. This indicates that an OnSurface sketch relations will be created between the sketch point and the cylindrical face. The hole is displayed in the model.
7. Insert a .25in dimension between the top face and the sketch point.

Locate the point angularly around the cylinder. Apply construction geometry.
8. Display the Temporary Axes.
9. Click the **Line** Sketch tool. Note: 3D Sketch is still activated.

10. **Ctrl + Click** the top flat face of the model. This moves the red space handle origin to the selected face. This also constrains any new sketch entities to the top flat face.

    Note the mouse pointer icon.

11. Move the **mouse pointer** near the center of the activated top flat face as illustrated. View the small black circle. The circle indicates that the end point of the line will pick up a Coincident relation.

12. Click the **center point** of the circle.

13. Sketch a line so it picks up the **AlongZ sketch relation**. The cursor displays the relation to be applied. **This is a very important step.**

    Deselect the Line Sketch tool.

14. Right-click **Select**.

15. Create an **AlongY** sketch relation between the center point of the hole on the cylindrical face and the endpoint of the sketched line. The sketch is fully defined.

16. Click **OK** from the PropertyManager.

17. Click **OK** to return to the Part FeatureManager.

18. **Expand** the FeatureManager and view the results. The two sketches are fully defined.

    One sketch is the hole profile, the other sketch is to define the position of the feature.

19. **Close** the model.

    Create a second sketched line and insert an angle dimension between the two lines. This process is used to control the position of the center point of the hole on the cylindrical face as illustrated.

    Insert an **AlongY** sketch relation between the center point of the hole on the cylindrical face and the end point of the second control line. Control the hole’s position with an angular dimension.
The main advantage of the 3D Sketch placement method is that it can place a set of holes on any set of solid faces, regardless of whether they are at different levels, are non-parallel. A limitation; 3D sketches can be fairly cumbersome and difficult. See section on 3D Sketching in SolidWorks Help for additional details.

2D Sketching/Inserting Reference Planes

Reference Planes are geometry created from existing planes, faces, vertices, surfaces, axes, and or sketch geometry. To access the Plane PropertyManager, click Insert ➤ Reference Geometry ➤ Plane from the Menu bar or click the Plane tool from the Consolidated Reference Geometry Features toolbar.

Plane Tool

The Plane tool uses the Plane PropertyManager. The Plane PropertyManager provides the following selections:

- **First Reference**: Select a face, plane or edge to create a reference plane. The options are available:
  - **Reference Entities**: Displays the selected planes either from the FeatureManager or from the Graphics window.
  - **Parallel**: Creates a plane parallel to the selected plane. For example, select a face for one reference and a point for another reference. The created plane is parallel to the face and coincident to the point.
  - **Perpendicular**: Creates a plane perpendicular to the selected reference. For example, select an edge or curve for one reference and a point or vertex for another reference.
• **Coincident.** Creates a plane through a point coincident to a plane or a face.

• **Project.** Projects a singular entity such as a point, vertex, origin, or coordinate system onto a non-planar surface. Select the sketch point and the model surface. Two options appear in the PropertyManager:
  - Nearest location on surface.
  - Along sketch normal.

• **Tangent.** Creates a plane tangent to cylindrical, conical, non-cylindrical, and non-planar faces. Select a surface and a sketch point on the surface. The plane is created tangent to the surface and coincident to the sketch point.

• **At Angle.** Select a plane or planar face and select an edge, axis, or sketch line. You can specify the number of planes to create. Enter the angle value in the angle box.

• **Offset Distance.** Creates a plane parallel to a plane or face, offset by a specified distance. You can specify the number of planes to create. Enter the Offset distance value in the distance box.

  • **Reverse direction.** Reverses the direction of the angle if required.

  • **Numbers of Planes to Create.** Displays the selected number of planes.

• **Mid Plane.** Creates a mid-plane between planar faces, reference planes, and 3D sketch planes. Select Mid Plane for both references.
**Tutorial: Reference Plane 4-1**
Create three Reference planes using the Offset Distance option from the Plane PropertyManager.

1. Create a New part. Use the default ANSI Part template. Set system units to MMGS.
2. Display an Isometric view.
3. Right-click Top Plane from the FeatureManager design tree.
4. Hold the Ctrl key down.
5. Click and drag the boundary of the Top Plane upwards in the Graphics window. The Plane PropertyManager is displayed. Top Plane is displayed in the First Reference box.
6. Release the Ctrl key and mouse pointer.
7. Enter 25mm in the Distance. The Plane is offset by 25mms. Enter 3 in the Number of planes to create box.
8. Click OK from the Plane PropertyManager. Plane1, Plane2 and Plane3 are created and displayed in the Graphics window. Each Plane is offset from the Top Plane a distance of 25mm.
9. Close the model.

**Tutorial: Reference Plane 4-2**
Use the Plane PropertyManager to create two angled Reference planes from an edge at a 45 degree angle.

1. Open Reference Plane 4-2 from the SolidWorks 2015 folder.
2. Click Right Plane from the FeatureManager design tree.
3. Click Insert ▶ Reference Geometry ▶ Plane from the Menu bar. The Plane PropertyManager is displayed. Right Plane is displayed in the First Reference box.
4. Click the At angle button.
5. Enter 45deg for Angle.
6. Click the **front vertical edge** of Extrude1 as illustrated. Do not select the midpoint. Edge<1> is displayed in the Selections box. The model is fully defined.

7. Enter 2 in the Number of planes to create box. Click **OK** from the Plane PropertyManager. Plane1 and Plane2 are displayed in the FeatureManager and in the Graphics window.

8. **Close** the model.

**Tutorial: Reference Plane 4-3**

Use the Plane PropertyManager to create a Reference plane using three vertices (Coincident) to the Extrude1 feature.

1. Open **Reference Plane 4-3** from the SolidWorks 2015 folder.

2. Click **Insert ➤ Reference Geometry ➤ Plane**. The Plane PropertyManager is displayed.

3. Click **three Vertices** as illustrated. Vertex<1>, Vertex<2> and Vertex<3> are displayed in the Reference Entities boxes. The model is fully defined.

4. Click **OK** from the Plane PropertyManager. The angled Plane1 is created and is displayed in the FeatureManager and the Graphics window.

5. **Close** the model.

💡 Fully define all sketches in the model. However; there are times when this is not practical. Generally when using the Spline tool to create a complex freeform shape.
**Tutorial: Reference Plane 4-4**

Use the Plane PropertyManager to create a Reference plane parallel to an existing plane, through a selected point.

1. Open **Reference Planes 4-4** from the SolidWorks 2015 folder.
2. Click the Plane tool from the Consolidated Reference Geometry Features toolbar. The Plane PropertyManager is displayed.
3. Click the front top right vertex.
4. Click the Right Plane from the fly-out FeatureManager. The model is fully defined.
5. Click OK from the Plane PropertyManager. Plane1 is created and is displayed in the FeatureManager and Graphics window.
6. Close the model.

**Parent/Child Relationship**

A Parent feature or sketch is an existing feature or sketch on which others depend on. Example of a Parent feature: An Extruded feature is the Parent feature to a fillet which rounds the edges.

When you create a new feature or sketch which is based on other features or sketches, their existence depends on the previously built feature or sketch. The new feature or sketch is called a Child feature or a Child sketch. Example of a Child feature: A hole is the child of the Base-Extrude feature in which it is cut.

**Tutorial: Parent-Child 4-1**

View the Parent/Child relationship in an assembly for a feature and a sketch from a component.

1. Open the **AirCylinder Linkage** assembly from the SolidWorks 2015\Solutions folder.
2. Expand RodClevis<1> from the AirCylinder Linkage assembly FeatureManager.
3. Right-click Base-Extrude.
5. Click Close from the Parent/Child Relationships dialog box.
View the Parent/Child Relationships for a feature.
6. Right-click **Sketch2** from Base-Extrude in the FeatureManager design tree.
7. Click **Parent/Child**. View the Base-Extrude feature relationships.
8. Click **Close** from the Parent/Child Relationships dialog box.
9. **Close** the model.

### Sketch States

Sketches can exist in any of five states. The state of the sketch is displayed in the status bar at the bottom of the SolidWorks window. The five sketch states in SolidWorks are:

1. **Under Defined.** Inadequate definition of the sketch, (blue). The FeatureManager displays a minus (-) symbol before the Sketch name.
2. **Fully Defined.** Complete information, (black). The FeatureManager displays no symbol before the Sketch name.
3. **Over Defined.** Duplicate dimensions and or relations, (orange-red). The FeatureManager displays a (+) symbol before the Sketch name. The What’s Wrong dialog box is displayed.
4. **Invalid Solution Found.** Your sketch is solved but results in invalid geometry. Example: such as a zero length line, zero radius arc or a self-intersecting spline (yellow).
5. **No Solution Found.** Indicates sketch geometry that cannot be resolved, (Brown).

The SolidWorks SketchXpert is designed to assist in an over defined state of a sketch. The SketchXpert generates a list of causes for over defined sketches. The list is organized into Solution Sets. This tool enables you to delete a solution set of over defined dimensions or redundant relations without compromising your design intent.

With the SolidWorks software, it is not necessary to fully dimension or define sketches before you use them to create features. You should fully define sketches before you consider the part finished for manufacturing.

Click **Options ➤ System Options ➤ Sketch**, and click the **Use fully defined sketches** option to use fully defined sketches for created features.
Apply dimensions and relations calculated by the SolidWorks application to fully define sketches or selected sketch entities. Use the Fully Defined Sketch PropertyManager.

**Sketch Entities**

Sketch entities provide the ability to create lines, rectangles, parallelograms, circles, etc. during the sketching process. To access the available sketch entities for SolidWorks, click **Tools ➤ Sketch Entities** from the Menu bar menu and select the required entity. This book does not go over each individual Sketch entity in full detail but will address the more advance entities.

To obtain additional information of each sketch entity, activate the sketch entity and click the question mark icon located at the top of the entity PropertyManager or click **Help ➤ SolidWorks Help Topics** from the Menu bar and search by using one of the three available tabs: **Contents**, **Index**, or **Search**.

**Line Sketch Entity**

The Line Sketch entity tool provides the ability to sketch multiple 2D lines in a sketch. The Line Sketch entity uses the Insert Line PropertyManager. The Insert Line PropertyManager provides the following selections:

- **Orientation**. The Orientation box provides the following options:
  - **As sketched**. Sketch a line in any direction using the click and drag method. Using the click-click method, the As sketched option provides the ability to sketch a line in any direction, and to continue sketching other lines in any direction, until you double-click to end your process.
  - **Horizontal**. Sketch a horizontal line until you release your mouse pointer.
  - **Vertical**. Sketch a vertical line until you release your mouse pointer.
  - **Angle**. Sketch a line at an angle until you release your mouse pointer.
Design Intent, Sketching and Sketch Entities

- **Options.** The Options box provides two line types. They are:
  - **For construction.** Converts the selected sketch entity to construction geometry.
  - **Infinite length.** Creates a line of infinite length which you can later trim in the design process.
  - **Midpoint line.** Create a line that is symmetrical from the midpoint of the line.

- **Parameters.** You can specify any appropriate combination of the following parameters (or Additional Parameters) to define the line if the line is not constrained by relations. When you change one or more parameters, the other parameters update automatically.

  Use Construction geometry to assist in creating your sketch entities and geometry that are ultimately incorporated into the part. Construction geometry is ignored when the sketch is used to create a feature. Construction geometry uses the same line style as a centerline.

  The plane or face you select for the Base sketch determines the orientation of the part.

**Rectangle and Parallelogram Sketch Entity**

The Rectangle Sketch entity tool provides the ability to sketch a Corner Rectangle, Center Rectangle, 3 Point Corner Rectangle and a 3 Point Center Rectangle. The Parallelogram Sketch entity provides the ability to sketch a Parallelogram.

The Rectangle and Parallelogram Sketch entity uses the Consolidated Rectangle PropertyManager. The Rectangle PropertyManager provides the following selections:

- **Rectangle Type.** The Rectangle Type box provides five selections. They are:
  - **Corner Rectangle.** Sketch a standard rectangle at a corner point. Click to place the first corner of the rectangle, drag, and release when the rectangle is the correct size and shape.
  - **Center Rectangle.** Sketch a rectangle at a center point. Click to define the center. Drag to sketch the rectangle with centerlines. Release to set the four edges.
  - **3 Point Corner Rectangle.** Sketch a rectangle at a selected angle. Click to define the first corner. Drag, rotate, and then release to set the length and angle of the
first edge. Click and drag to sketch the other three edges. Release to set the four edges.

- **3 Point Center Rectangle.** Sketch a rectangle with a center point at a selected angle. Click to define the first corner. Drag and rotate to set one half the length of the centerlines. Click and drag to sketch the other three edges and centerlines. Release to set the four edges.

- **Parallelogram.** Sketch a standard parallelogram. A Parallelogram is a rectangle whose sides are not horizontal or vertical with respect to the sketch grid. Click to define the first corner. Drag, rotate, and then release to set the length and angle of the first edge. Click, rotate, and drag to set the angle and length of the other three edges. Release to set the four edges.

- **Options.** For construction.

- **Parameters.** Specify the appropriate combination of parameters to define the rectangle or parallelogram if they are not constrained by relations.

### Slot Sketch Entity

The Slot Sketch entity tool provides the ability to sketch a *Straight Slot*, *Centerpoint Straight Slot*, *3 Point Arc Slot* and a *Centerpoint Arc Slot* from the Consolidated Slot toolbar.

The Slot Sketch entity uses the Consolidated Slot PropertyManager. The Slot PropertyManager provides the following selections:

- **Slot Type.** The Slot Type box provides four selections. They are:
  - **Straight Slot.** Sketch a three point slot.
  - **Centerpoint Straight Slot.** Sketch a three point slot located at an Origin or centerpoint.
  - **3 Point Arc Slot.** Sketch a four point arc slot.
  - **Centerpoint Arc Slot.** Sketch a four point arc slot located at an Origin or reference point.
• **Add dimensions.** Insert dimensions as you sketch the slot.

• **Center to Center.** Insert center to center dimension if the Add dimensions box is checked.

• **Overall Length.** Insert overall length if the Add dimensions box is checked.

• **Parameters.** Provides the ability to specify the appropriate combination of parameters to define slot if they are not constrained by relations. The parameters box provides the following options: **Center X Coordinate, Center Y Coordinate, Radius of Arc, Angle of Arc, Slot Width, Slot Length.**

**Tutorial: Slot Sketch - Instant3D 4-1**

Utilize the Slot Sketch tool. Create an Extruded Boss/Base and Extruded Cut feature using the Instant3D tool.

1. Create a **New** part. Use the default ANSI, IPS Part template.
2. Right-click **Front Plane** from the FeatureManager.
3. Click **Sketch** from the Context toolbar. The Sketch toolbar is displayed.
4. Click **Centerpoint Straight Slot** from the Consolidated Slot toolbar as illustrated. The Slot PropertyManager is displayed. If needed, uncheck the Add dimension box.
5. Click the **Origin**.
6. Click a **position** directly to the right of the Origin.
7. Click a **position** directly above the second point as illustrated.

Dimension the slot sketch.

8. Right-click **Smart Dimension** from the Context toolbar in the Graphics window.
9. **Dimension** the model as illustrated. The sketch is fully defined. Note the location of the Origin.
Apply the Instant3D tool. Create an Extruded Boss/Base feature. The Extruded Boss/Base feature adds material to a part. Note: Edit the feature, view the PropertyManager to confirm that you picked the correct dimension with the on-screen ruler. The Instant3D tool does not provide various End Conditions for Design Intent.

Exit Sketch1.

10. Right-click Exit Sketch. Note: Instant3D is active by default. If needed click Instant3D from the Features tab.

11. Display an **Isometric view**.

Create an Extruded Boss/Base feature with a default Blind End Condition.

12. Click the **top edge** as illustrated. A green arrow is displayed.

13. Drag the **green arrow** forward and click the on-screen ruler at the **0.25** dimension. View Boss-Extrude1 in the FeatureManager. Depth = .25in.

Create an Extruded Cut feature using Instant3D.

14. Display a **Front view**.

15. Right-click the **Front face**. This is your Sketch plane.

16. Click **Sketch** from the Context toolbar. The Sketch toolbar is displayed.

17. Click the **Circle** Sketch tool.

18. Sketch a **circle** centered at the Origin as illustrated.

Exit the Sketch.

19. Right-click Exit Sketch.

20. Display an **Isometric view**.

Create an Extruded Cut feature.

21. Click the **circumference** of the sketch as illustrated. A green arrow is displayed.

22. Click and drag the green arrow **backwards** to create a hole in the model. Note: The default End Condition is Blind.

23. **Release** the mouse icon behind the model. The Cut-Extrude1 feature is displayed. View the model.
24. **Close** the model.

**Polygon Sketch Entity**

The Polygon Sketch entity tool provides the ability to create equilateral polygons with any number of sides between 3 and 40. The Polygon Sketch entity uses the Polygon PropertyManager. The Polygon PropertyManager provides the following selections:

- **Existing Relations**. The Existing Relations box displays information on existing relations of the polygon sketch.

- **Add Relation**. The Add Relation box displays the selected relations to the points and lines of your polygon sketch.

💡 You cannot add a relation to a complete polygon. You can only add a relation to the points and lines of the polygon.

- **Options**. The Options box provides the following selection:
  - **For construction**. Not selected by default. Converts the selected sketch entity to construction geometry.

- **Parameters**. The Parameters box provides the ability to specify the appropriate combination of parameters to define the polygon. When you modify or change one or more parameters, the other parameters update automatically. The available selections are:
  - **Number of Sides**. Sets the number of sides in your polygon.
  - **Inscribed circle**. Selected by default. Displays an inscribed circle inside the polygon. This option defines the size of the polygon. The circle is construction geometry.
  - **Circumscribed circle**. Displays a circumscribed circle outside of the polygon. This option defines the size of the polygon. The circle is construction geometry.
  - **Center X Coordinate**. Displays the X coordinate for the center of your polygon.
• **Center Y Coordinate.** Displays the Y coordinate for the center of your polygon.

• **Circle Diameter.** Displays the diameter of the inscribed or circumscribed circle.

• **Angle.** Displays the angle of rotation.

• **New Polygon.** Creates more than a single polygon without leaving the PropertyManager.

**Tutorial: Polygon 4-1**

Create a new part using the Polygon Sketch entity.

1. Create a **New** part. Use the default ANSI Part template.

2. Right-click **Top Plane** from the FeatureManager design tree. This is your Sketch plane.

3. Click **Sketch** from the Context toolbar. The Top Plane boundary is displayed in the Top view in the Graphics window.

4. Click the **Circle** Sketch tool. The Circle PropertyManager is displayed.

5. Sketch a **circle** centered at the origin. The mouse cursor displays the Circle icon symbol.

   Insert a polygon.

6. Click **Tools > Sketch Entities > Polygon** from the Menu bar or click **Polygon** from the Sketch toolbar. The Polygon PropertyManager is displayed. The mouse cursor displays the Polygon symbol.

7. Sketch a **Polygon** centered at the Origin larger than the circle as illustrated.

8. Click **OK** from the Polygon PropertyManager.

9. **Rebuild** the model. View the created Polygon in the Graphics window.

10. **Close** the model.

   For illustration purposes, the Reference planes and grid are hidden.
Circle Sketch and Perimeter Circle Sketch Entity

The Circle Sketch and Perimeter Circle Sketch entity tool provides the ability to control the various properties of a circle.

The Circle Sketch and Perimeter Circle Sketch entity uses the consolidated Circle PropertyManager. The consolidated Circle PropertyManager provides the following selections:

- **Circle Type.** Provides the ability to select either a center based circle or a perimeter-based circle sketch entity.

- **Existing Relations.** The Existing Relations box provides the following options:
  - **Relations.** Displays the automatic relations inferred during sketching or created manually with the Add Relations tool. The callout in the Graphics window is highlighted when you select a relation in the dialog box. The Information icon in the Existing Relations box displays the sketch status of the selected sketch entity. Example: Under Defined, Fully Defined, etc.
  - **Add Relations.** Provides the ability to add relations to the selected entity. Displays the relations which are possible for the selected entity.
  - **Options. For construction.** Not selected by default. Converts the selected entity to construction geometry.
  - **Parameters.** Specifies the appropriate combination of parameters to define the circle if the circle is not constrained by relations. The available selections are:
    - **Center X Coordinate.** Sets the Center X Coordinate value.
    - **Center Y Coordinate.** Sets the Center Y Coordinate value.
    - **Radius.** Sets the Radius value.
The Perimeter Circle Sketch entity provides the ability to define a circle using 3 points along its perimeter. This sketch entity is very useful when you are not concerned about the location of the center of the circle.

**Tutorial: Perimeter Circle 4-1**

Create a Perimeter Circle sketch.
1. Create a New part. Use the default ANSI Part template.
2. Right-click Front Plane from the FeatureManager. This is your Sketch plane.
3. Click Sketch from the Context toolbar.
4. Click the Line Sketch tool. The Insert Line PropertyManager is displayed.
5. Sketch two lines as illustrated.
6. Click Perimeter Circle from the Consolidated Circle Sketch toolbar. The Circle PropertyManager is displayed.
7. Click each line once.
8. Click a position as illustrated to determine the size of the circle. The X coordinate, Y coordinate, and Radius are displayed in the Parameters box. The two lines are tangent to the circle. You created a simple circle using the Perimeter Circle sketch entity.
9. Click OK from the Circle PropertyManager. View the model.
10. Rebuild the model.
11. Close the model.

If the two lines change, the circle remains tangent to the lines.

In System Options, apply the Ghost image on drag option. The option displays a ghost image of a sketch entities’ original position while you drag the sketch in the Graphics window.
Centerpoint Arc Sketch Entity

The Centerpoint Arc Sketch entity tool provides the ability to create an arc from a center point, a start point, and an end point. The Centerpoint Arc Sketch entity uses the consolidated Arc PropertyManager.

The Arc PropertyManager controls the properties of a sketched Centerpoint Arc, Tangent Arc and 3 Point Arc.

The consolidated Arc PropertyManager provides the following selections:

- **Arc Type.** Provides the ability to select a Centerpoint Arc, Tangent Arc or 3 Point Arc sketch entity.

- **Existing Relations.** The Existing Relations box provides the following options:
  - **Relations.** Displays the automatic relations inferenced during sketching or created manually with the Add Relations tool. The callout in the Graphics window is highlighted when you select a relation in the dialog box. The Information icon in the Existing Relations box displays the sketch status of the selected sketch entity. Example: Under Defined, Fully Defined, etc.

  - **Add Relations.** Provides the ability to add relations to the selected entity. Displays the relations which are possible for the selected entity.

  - **Options. For construction.** Converts the selected entity to construction geometry.

  - **Parameters.** Provides the ability to specify any appropriate combination of parameters to define your arc if the arc is not constrained by relations. The available selections are: Center X Coordinate, Center Y Coordinate, Start X Coordinate, Start Y Coordinate, End X Coordinate, End Y Coordinate, Radius and Angle.
**Tutorial: Centerpoint Arc 4-1**

Create a Centerpoint Arc sketch.

1. Create a **New** part. Use the default ANSI Part template.
2. Right-click **Front Plane** from the FeatureManager. This is your Sketch plane.
3. Click **Sketch** from the Context toolbar.
4. Click the **Line** Sketch tool.
5. Sketch a **horizontal line** through the origin as illustrated.
6. Click **Centerpoint Arc** from the Consolidated Arc Sketch toolbar. The Arc icon is displayed on your mouse pointer.
7. Click a location on the **horizontal line** left of the origin. Do not pick the origin or the endpoint.
8. Click a **position** to the right and up on the horizontal line.
9. Drag to set the **angle** and the radius of the arc.
10. Release the **mouse** button to place the arc. View the Arc PropertyManager and the coordinates.
11. Click **OK** from the Arc PropertyManager.
12. **Rebuild** the model.
13. **Close** the model.

**Tangent Arc Sketch Entity**

The Tangent Arc Sketch entity tool provides the ability to create an arc, which is tangent to a sketch entity. The Tangent Arc Sketch entity uses the Arc PropertyManager. View the Centerpoint Arc Sketch entity section above for additional information on the Arc PropertyManager.

💡 You can transition from sketching a line to sketching a Tangent Arc, and vice versa without selecting the Arc tool from the Sketch toolbar. Example: Create a line. Click the endpoint of the line. Move your mouse pointer away. The Preview displays another line. Move your mouse pointer back to the selected line endpoint. The Preview displays a tangent arc. Click to place the arc. Move the mouse pointer away from the arc endpoint. Perform the same procedure above to continue.
**Tutorial: Tangent Arc 4-1**

Create a Tangent Arc sketch.

1. Create a New part. Use the default ANSI Part template.
2. Right-click Front Plane from the FeatureManager.
3. Click Sketch from the Context toolbar.
4. Click the Line Sketch tool.
5. Sketch a horizontal line through the Origin.
6. Click Tangent Arc from the Consolidated Arc Sketch toolbar. The Arc icon is displayed on the mouse pointer.
7. Click the left end point of the horizontal line.
8. Drag the mouse pointer upward and to the left for the desired shape.
9. Click an end point. You created a Tangent Arc. The Arc PropertyManager is displayed.
10. Right-click Select in the Graphics window to deselect the Sketch tool.
11. Click OK from the Arc PropertyManager.
12. Exit the sketch.
13. Close the model.

💡 You can select an end point of a line, ellipse, arc or a spline. The Tangent Arc tool creates both Normal and Tangent Arcs.

**3 Point Arc Sketch Entity**

The 3 Point Arc Sketch entity tool provides the ability to create an arc by specifying three points; a starting point, an endpoint, and a midpoint. View the Centerpoint Arc Sketch entity section for additional information on the Arc PropertyManager.

**Tutorial: 3 Point Arc 4-1**

Create a 3Point Arc sketch.

1. Open 3 Point Arc 4-1 from the SolidWorks 2015 folder.
2. Edit Sketch1.
3. Click 3 Point Arc from the Consolidated Arc Sketch toolbar.
4. Click the **top point** of the vertical line for the start point as illustrated.

5. Click the **right point** of the open circle for the end point as illustrated.

6. Drag the **arc** downward to set the radius.

7. Click a **position** for the midpoint of the 3Point Arc.

8. Click **OK** from the Arc PropertyManager.

9. **Rebuild** the model. **Close** the model.

---

**Ellipse Sketch Entity**

The Ellipse Sketch entity tool provides the ability to create a complete ellipse. The Ellipse PropertyManager controls the properties of a sketched Ellipse or a Partial Ellipse. The Ellipse PropertyManager provides the following selections:

- **Existing Relations**. The Existing Relations box provides the following options:
  - **Relations**. Displays the automatic relations inferenced during sketching or created manually with the Add Relations tool. The callout in the Graphics window is highlighted when you select a relation in the dialog box. The Information icon in the Existing Relations box displays the sketch status of the selected sketch entity. Example: Under Defined, Fully Defined, etc.
  - **Add Relations**. Provides the ability to add relations to the selected entity. Displays the relations which are possible for the selected entity.
  - **Options**. The Options box provides the following selection:
    - **For construction**. Converts the selected entity to construction geometry.
  - **Parameters**. Provides the ability to specify any appropriate combination of parameters to define the ellipse if the ellipse is not constrained by relations. The available selections are: **Center X Coordinate**, **Center Y Coordinate**, **Start X Coordinate** (only available for a Partial Ellipse), **Start Y Coordinate** (only available for a Partial Ellipse), **End X Coordinate** (only available for a Partial Ellipse), **End Y Coordinate** (only available for a Partial Ellipse), **Radius 1**, **Radius 2** and **Angle** (only available for a Partial Ellipse).
Tutorial: Ellipse 4-1
Create an Ellipse sketch.

1. Create a New part. Use the default ANSI Part template.
2. Right-click Front Plane from the FeatureManager. This is your Sketch plane.
3. Click Sketch from the Context toolbar.
4. Click the Ellipse Sketch tool. The Ellipse icon is displayed on the mouse pointer.
5. Click the origin in the Graphics window. This is the start location.
6. Drag and click to set the major axis of the ellipse. The ellipse PropertyManager is displayed.
7. Drag and click again to set the minor axis of the ellipse.
8. Deselect the sketch tool.
10. Add a vertical geometric relation in the sketch.
11. Hold the Ctrl key down.
12. Click the top vertical point and the bottom vertical point of the Ellipse.
13. Right-click Make Vertical from the Pop-up menu.
14. View the sketch.
15. Close the model.

Partial Ellipse Sketch Entity

The Partial Ellipse Sketch entity tool provides the ability to create a partial ellipse or an elliptical arc from a centerpoint, a start point, and an end point. You use a similar procedure when you created a Centerpoint Arc. The Ellipse PropertyManager controls the properties of a sketched Ellipse or a Partial Ellipse. View the Ellipse section for additional information on the Ellipse PropertyManager.
Parabola Sketch Entity

The Parabola Sketch entity provides the ability to create a parabolic curve. The Parabola Sketch entity uses the Parabola PropertyManager. The Parabola PropertyManager provides the following selections:

- **Existing Relations.** The Existing Relations box provides the following options:
  - **Relations.** Displays the automatic relations inferenced during sketching or created manually with the Add Relations tool. The callout in the Graphics window is highlighted when you select a relation in the dialog box. The Information icon in the Existing Relations box displays the sketch status of the selected sketch entity. Example: Under Defined, Fully Defined, etc.
  - **Add Relations.** Provides the ability to add relations to the selected entity. Displays the relations which are possible for the selected entity.
  - **Options.** For construction. Not selected by default. Converts the selected entity to construction geometry.
  - **Parameters.** Provides the ability to specify the appropriate combination of parameters to define the parabola if the parabola is not constrained by relations. The available selections are: 
    - Start X Coordinate, Start Y Coordinate, End X Coordinate, End Y Coordinate, Center X Coordinate, Center Y Coordinate, Apex X Coordinate and Apex Y Coordinate.

Tutorial: Parabola 4-1

Create a Parabola sketch.

1. Create a New part. Use the default ANSI, IPS Part template.
2. Right-click Front Plane from the FeatureManager. This is your Sketch plane.
3. Click Sketch from the Context toolbar.
4. Apply the Parabola Sketch tool.
5. Click the Parabola Sketch tool from the Consolidated Sketch toolbar. The Parabola icon is displayed on the mouse pointer.
5. Click a **position** in the Graphics window to locate the focus of your parabola.

6. Drag to **enlarge** the parabola. The parabola is outlined.

7. Click on the **parabola** and drag to define the extent of the curve. The Parabola PropertyManager is displayed.

8. Click **OK** from the Parabola PropertyManager.

9. **Rebuild** the model.

10. **Close** the model.

### Conic Sketch Entity

The Conic Sketch entity tool provides the ability to sketch conic curves driven by endpoints and Rho value. Depending on the Rho value, the curve can be elliptical, parabolic, or hyperbolic. In previous versions of the SolidWorks software, you could sketch ellipses and parabolas. However, you could not sketch ellipses or parabolas by their endpoints, so it was difficult to make them tangent to existing geometry.

Conic curves can reference existing sketch or model geometry, or they can be standalone entities. You can dimension the curve with a driving dimension, and the resulting dimension displays the Rho value. The conic entity also includes a value for the radius of curvature.

**Auto Tangency** accelerates the process of sketching a conic curve. When you select this option in the Conic PropertyManager, you set the first and second endpoints for the conic curve. The Conic tool applies tangent relations at each endpoint of the curve and selects the top vertex of the curve. This option is helpful when you reference existing geometry. If you clear this option, you must define the top vertex of the curve.
The Conic Sketch entity uses the Conic PropertyManager. The Conic PropertyManager provides the following selections:

- **Existing Relations.** The Existing Relations box provides the following options:
  - **Relations.** Displays the automatic relations inferred during sketching or created manually with the Add Relations tool. The callout in the Graphics window is highlighted when you select a relation in the dialog box. The Information icon in the Existing Relations box displays the sketch status of the selected sketch entity. Example: Under Defined, Fully Defined, etc.
  - **Add Relations.** Provides the ability to add relations to the selected entity. Displays the relations which are possible for the selected entity.
  - **Options.** The Options box provides the following selection:
    - **For construction.** Not selected by default. Converts the selected entity to construction geometry.
  - **Parameters.** Provides the ability to specify the appropriate combination of parameters to define the parabola if the parabola is not constrained by relations. The available selections are: **Start X Coordinate, Start Y Coordinate, End X Coordinate, End Y Coordinate, Center X Coordinate, Center Y Coordinate, Apex X Coordinate, and Apex Y Coordinate**.

**Tutorial: Conic 4-1**

Create a Conic sketch.
1. Open **Conic 4-1** from the SolidWorks 2015 folder. The model contains an arc and spline.

   Apply the Conic Sketch tool.
2. Click the **Conic** Sketch tool from the Consolidated Sketch toolbar. The Conic icon is displayed on the mouse pointer.

   Click the first endpoint for the conic curve as illustrated.
4. Drag the **pointer to the right** so it’s tangent with the arc. Because the endpoint is attached to the existing arc sketch, a yellow inferencing line is displayed.

5. Click the **second endpoint** as illustrated.

6. Drag the **mouse pointer** upwards. A yellow inferencing line is displayed tangent to the spline sketch.

7. Drag the mouse pointer out to the **intersection** of the two yellow inferencing lines. You can snap to the intersection of both inference lines to choose the top vertex of the conic curve.

8. Click at the **intersection of both inferencing lines** to set the top vertex of the conic curve. By selecting the intersection of both inferencing lines, you ensure that the conic curve is tangent at both endpoints.

9. Drag the **pointer to the left** until the Rho value is 0.75. As you move the pointer, the conic curve's Rho value changes.

10. **Click** to set the Rho value to 0.75. Reference points are displayed for the curve's shoulder and top vertex. Tangent relations are created between the curve and the original sketches.

11. Click **OK** from the Conic PropertyManager.

12. **Rebuild** the model.

13. **Close** the model.

Conic surfaces are very useful for precision flowing (aerodynamic) shapes. It is best to have no more than one singular point on a surface. The mid line curve is usually shared by the top and bottom fuselage shape surfaces.

Rho is the squarness for conic, and translates into the squarness of the surface. In theory at 1.0 it is a dead sharp corner, 0.8 is a very modern squarish corner, 0.6 is most useful for airplane fuselages, 0.4 looks like an ellipse, and 0.1 is a slanted ellipse section that tends toward a line between the end points.
Spline Sketch Entity

The Spline Sketch entity tool provides the ability to create a profile that utilizes a complex curve. This complex curve is called a Spline, (Non-uniform Rational B-Spline or NURB).

Create a spline with control points. With spline control points, you can:

- Use spline points as handles to pull the spline into the shape you want.
- Add dimensions between spline points or between spline points and other entities.
- Add relations to spline points.

The 2D Spline PropertyManager provides the following selections:

- **Existing Relations.** The Existing Relations box provides the following options:
  - **Relations.** Displays the automatic relations inferenced during sketching or created manually with the Add Relations tool. The callout in the Graphics window is highlighted when you select a relation in the dialog box. The Information icon in the Existing Relations box displays the sketch status of the selected sketch entity. Example: Under Defined, Fully Defined, etc.

- **Add Relations.** Provides the ability to add relations to the selected entity. Displays the relations which are possible for the selected entity.

- **Options.** The Options box provides the following selection:
  - **For construction.** Not selected by default. Converts the selected entity to construction geometry.
  - **Show Curvature.** Not selected by default. Provides the ability to control the Scale and Density of the curvature. Displays the Curvature of the spline in the Graphics window.
- **Maintain Internal Continuity.** Selected by default. Maintains the spline's internal curvature. When Maintain Internal Continuity is cleared, the curvature scales down abruptly.

- **Raised degree.** Available only with splines that include curvature handles at each end. Raises or lowers the degree of the spline. You can also adjust the degrees by dragging the handles.

- **Parameters.** Provides the ability to specify the appropriate combination of parameters. The available parameters are:
  - **Spline Point Number.** Highlights your selected spline point in the Graphics window.
  - **X Coordinate.** Specifies the x coordinate of your spline point.
  - **Y Coordinate.** Specifies the y coordinate of your spline point.
  - **Radius of Curvature.** Controls the radius of curvature at any spline point. This option is only displayed if you select the Add Curvature Control option from the Spline toolbar, and add a curvature pointer to the spline.
  - **Curvature.** Displays the degree of curvature at the point where the curvature control was added. This option is only displayed if you add a curvature pointer to the spline.
  - **Tangent Weighting1.** Controls the left tangency vector by modifying the spline’s curvature at the spline point.
  - **Tangent Weighting 2.** Controls the right tangency vector by modifying the spline’s curvature at the spline point.
  - **Tangent Radial Direction.** Controls the tangency direction by modifying the spline’s angle of inclination relative to the X, Y or Z axis.
Design Intent, Sketching and Sketch Entities

- **Tangent Polar Direction.** Controls the elevation angle of the tangent vector with respect to a plane placed at a point perpendicular to a spline point. This is only for the 3D Spline PropertyManager.

- **Tangent Driving.** Enables spline control by using the Tangent Magnitude option and the Tangent Radial Direction option.

- **Reset This Handle.** Returns the selected spline handle to the initial state.

- **Reset All Handles.** Returns the spline handles to their initial state.

- **Relax Spline.** Sketch your spline and display the control polygon. You can drag any node on the control polygon to change shape. If you are dragging results in a spline which is not smooth, re-select the spline to display the PropertyManager. Click the Relax Spline selection under the Parameters option. This will re-parameterize or smooth the shape of your spline.

- **Proportional.** Retains the spline shape when you drag the spline.

### Spline toolbar

Use the tools located on the Spline toolbar to control properties of a sketched spline. The Spline toolbar provides the following tools:

- **Add Tangency Control.** The Add Tangency Control tool adds a tangency control handle. Drag the control handle along the spline and position it to control the tangency at the selected point.

- **Add Curvature Control.** The Add Curvature Control tool adds a curvature control handle. Drag the control handle along the spline and position the control handle to control the spline shape at the selected point.

- **Insert Spline Point.** The Insert Spline Point tool adds a point to the spline. Drag spline points to reshape the spline.

- **Simplify Spline.** The Simplify Spline tool reduces the number of points in the spline. This function improves the performance in the model for complex spline curves.

- **Fit Spline.** The Fit Spline tool adds a spline based on the selected sketch entities and edges.
• **Show Spline Handles.** The Show Spline Handles tool displays all handles of the selected spline in the Graphic window. Use the spline handles to reshape the spline.

• **Show Inflection Points.** The Show Inflection Points tool displays all points where the concavity of a selected spline changes.

• **Show Minimum Radius.** The Show Minimum Radius tool displays the measurement of the smallest radius in the selected spline.

• **Show Curvature Combs.** The Show Curvature Combs tool displays the scalable curvature combs; which visually enhances the curves of your selected spline.

**Tutorial: Spline 4-1**

Create a 2D Spline sketch.

1. Create a **New** part. Use the default ANSI, IPS Part template.

2. Right-click **Right Plane** from the FeatureManager. This is your Sketch plane.

3. Click **Sketch** from the Context toolbar.

4. Click the **Spline** Sketch tool. The spline icon is displayed on the mouse pointer.

5. Create the Spline. This is an open profile. Create a **seven point control** spline as illustrated. Do not select the origin. The Spline PropertyManager is displayed.

6. Right-click **Select** on the last control point.

7. **Exit** the Spline tool.

8. Click and drag the **spline** from left to right. Do not select a control or handle. The spline moves without changing its shape.

9. Click **OK** from the Spline PropertyManager.

10. **Rebuild** the model. View the results.

11. **Close** the model.
Spline handles are displayed by default. To hide or display spline handles, click the Show Spline Handles tool from the Spline toolbar or click Tools ➔ Spline Tools ➔ Show Spline Handles.

**Tutorial: 2D Spline 4-2**

Dimension a 2D Spline handle.
1. Open 2D Spline 4-2 from the SolidWorks 2015 folder.
2. **Edit** Sketch1.

Use the Smart Dimension tool to dimension a spline handle. Display the handles.
3. Click the Spline in the Graphics window. The Spline PropertyManager is displayed. Locate the pointer on the top handle. The rotate icon is displayed.
4. Click the **top handle tip**.
5. **Rotate** the handle upwards as illustrated to create a Tangent Driving.
6. Right-click **Smart Dimension** from the Context toolbar.

Create a Tangent Radial dimension.
7. Click the **handle arrow tip**.
8. Click the **horizontal** line.
9. Enter 40 deg.
10. Set **precision** to none.
11. Click **OK** from the Dimension PropertyManager.
12. **Rebuild** the model. View the results.
13. **Close** the model.

For a Tangent Magnitude, select the arrow tip on the handle to add the dimension.

Illustrations may vary depending on your SolidWorks version and system setup.
**Tutorial: 3D Spline 4-1**
Create a 3D Spline part.
1. Create a New part. Use the default ANSI Part template.
2. Click Insert ➤ 3D Sketch from the Menu bar menu. Apply the Spline Sketch tool.
3. Click the Spline Sketch tool.
4. Click a location in the Graphics window to place the first spline point. Each time you click a different location, the space handle is displayed to help you sketch on a different plane.

💡 Press the Tab key to change planes in a 3D Sketch.
5. Click three additional locations as illustrated. The Spline PropertyManager is displayed.
6. Right-click End Spline.
7. Click Spline from the Sketch toolbar to exit the sketch tool.
8. Click OK from the Spline PropertyManager.
9. Exit the 3D Sketch. 3DSketch1 is created and displayed in the FeatureManager.
10. Close the sketch.

**Tutorial: 3D Spline 4-2**
Edit a 3D spline using the current elements.
1. Open 3D Spline 4-2 from the SolidWorks 2015 folder.
2. Edit 3DSketch1.
3. Click the Spline in the Graphics window. The Spline PropertyManager is displayed.
Modify the Spline shape using the click and drag method on a control point.
4. Click a spline control point as illustrated and drag it upward. The Point PropertyManager is displayed. View the results.
Modify the Spline shape using the x-, y- and z-coordinates method on a control point.
5. Click a **spline point** as illustrated. The Point PropertyManager is displayed.

6. Set values for x-, y-, and z-coordinates from the Point PropertyManager. You modified the shape of the spline.

Modify the Spline shape using the click and drag method on a handle.
7. Click a **spline handle** as illustrated.

8. Drag the selected **spline handle** to control the tangency vector by modifying the spline’s degree of curvature at the spline point. The Spline PropertyManager is displayed.

Reset the handle to the original location.
9. Click the **Reset This Handle** option. All values relative to the selected handle return to their original value.

Move the spline.
10. Click and drag the **spline** from left to right. Do not select a control point. As the spline is moved, it retains its shape.

11. Click **OK** from the Spline PropertyManager.

12. **Exit** the 3D Sketch. View the results.

13. **Close** the model.

**Tutorial: 3D Spline 4-3**

Add new elements to a 3D Spline.
1. Open **3D Spline 4-3** from the SolidWorks 2015 folder.

2. **Edit** 3DSketch1.

3. Click the **spline** from the Graphics window. The Spline PropertyManager is displayed.

4. Click the **Add Tangency Control** tool from the Spline toolbar.
5. Drag to **place** the handle as illustrated.

6. Click a **position** for the handle.

7. Click **OK** from the Spline PropertyManager.

8. **Exit** the 3D Sketch. View the results.

9. **Close** the model.

**Style Spline**

The Style Spline tool provides the ability to sketch single-span Bézier curves. These curves let you create smooth and robust surfaces, and are available in 2D and 3D sketches.

The Style Spline consists of only one span. You shape its curvature by selecting and dragging control vertex points. Sketch entities connect the control vertices which form the control polygon of the curve.

With the Style Spline tool, you can control the degree and continuity of the curves. You can inference style splines for tangency or equal curvature. You can constrain the points and dimension the curves' sides. These curves also support mirroring and self-symmetry.

**Spline on Surface Entity**

The Spline on Surface entity tool provides the ability to sketch splines on various surfaces. Splines sketched on surfaces include standard spline attributes, as well as the capabilities to add and drag points along the surface and to generate a preview that is automatically smoothed through the points.

💡 All spline points are bounded to the surface on which they are sketched.
**Tutorial: Spline on Surface 4-1**
Create a Closed Spline on Surface feature.

1. Open **Spline on Surface 4-1** from the SolidWorks 2015 folder.
2. Click the **top left face** as illustrated.
3. Click the **Spline on Surface** Sketch tool. The spline icon is displayed on the mouse pointer.
4. Create a **five point closed spline** as illustrated.
5. Click **Spline on Surface** to close the sketch tool.
6. Click the **Extruded Boss/Base** Features tool. The Boss-Extrude PropertyManager is displayed.
7. Click the **left vertical line** as illustrated for Direction 1. Edge<1> is displayed in the Direction of Extrusion box.
8. Enter **10mm** for Depth.
9. Click **OK** from the Boss-Extrude PropertyManager. Boss-Extrude1 is displayed. View the results in the Graphics window.
10. **Close** the model.

The Spline on Surface tool in 2015 works across multiple faces and is more robust for parametric updates. Splines on surfaces can:
- Span multiple faces.
- Update if model geometry is updated (unless the splines are constrained).
- You can move the points on the spline to different faces by dragging the points, but not by dragging the curve itself.
Intelligence Modeling - Equation Driven Curve

The Equation Driven Curve tool is a 2D Sketch spline driven by an equation. This Sketch entity provides the ability to create a curve by specifying the equations that define the curve. Equations defining a curve specify y- as a function of x-. You can use any function that is supported in the Equations dialog box. See Chapter 18 - Intelligence modeling techniques for additional information.

The Equation Driven Curve entity uses the Equation Driven Curve PropertyManager. The PropertyManager provides the following selections:

- **Equation Type.** There are equation types available: *Explicit* and *Parametric*.
- **Parameters.** The Parameters box provides the following options:
  - **Equation.** Provides the ability to enter an equation as a function of X-. If you enter an equation that can’t be resolved, the text color is displayed in red.
  - **Parameters.** Provides the ability to enter the start and end X value of the equation.
  - **Transform.** Provides the ability to enter the translation of X-, Y- and angle for the curve.

**Tutorial: Equation Driven Curve 4-1**
Create an Equation Driven Curve on the Front Plane.
1. Create a **New** part. Use the default ANSI, IPS Part template.

Create a 2D Sketch on the Front Plane.
2. Right-click **Front Plane** from the FeatureManager.
3. Click **Sketch** from the Context toolbar. The Sketch toolbar is displayed. Front Plane is your Sketch plane.
4. Click the **Equation Driven Curve** tool. The Equation Driven Curve PropertyManager is displayed. This tool provides the ability to build intelligences into a part. Specify the equation that defines the sketch. Note: y- is a function of x-

5. Enter: \(3x\sin(x)\) as illustrated in the Equation box.

6. Enter 0 for the start point as illustrated.

7. Enter \(4\pi\) for the end point. Note: You can fix the end points of the curve by applying the Fix tool.

8. Click **OK** from Equation Driven Curve PropertyManager. View the created curve. Note: click the curve in the Graphics window to edit the Parameters of the curve.

9. Click **Exit Sketch**. View the results.

10. **Close** the model.

💡 Use regular mathematical notation and order of operations to write an equation. \(x_1\) and \(x_2\) are for the beginning and end of the curve. Use the transform options at the bottom of the PropertyManager to move the entire curve in x-, y- or rotation. To specify \(x = f(y)\) instead of \(y = f(x)\), use a 90 degree transform.

💡 View the .mp4 movies located on the DVD in the book to better understand the potential of the Equation Driven Curve tool. The first one: Calculating Area of a region bounded by two curves \((\sec x)^2\) and \(\sin x\) in SolidWorks - the second one: Determine the Volume of a Function Revolved Around the x Axis in SolidWorks. Both are located in the SolidWorks 2015 folder.

### Curve Through XYZ Points

The Curve Through XYZ Points feature provides the ability to either type in (using the Curve File dialog box) or click Browse and import a text file using x-, y-, z-, coordinates for points on a curve.

A text file can be generated by any program which creates columns of numbers. The Curve feature reacts like a default spline that is fully defined.
Create a curve using the Curve Through XYZ Points tool. Import the x-, y-, z- data. Verify that the first and last points in the curve file are the same for a closed profile.

💡 It is highly recommend that you insert a few extra points on either end of the curve to set end conditions or tangency in the Curve File dialog box.

Imported files can have an extension of either *.sldcrv or *.text. The imported data: x-, y-, z-, must be separated by a space, a comma, or a tab.

**Tutorial: Curve Through XYZ points 4-1**

Create a curve using the Curve Through XYZ Points tool. Import x-, y-, z- data from a CAM program. Verify that the first and last points in the curve file are the same for a closed profile.

1. Open Curve Through XYZ points 4-1 from the SolidWorks 2015 folder.

2. Click the **Curve Through XYZ Points** tool from the Features CommandManager. The Curve File dialog box is displayed.

   Import x-, y-, z- data. Verify that the first and last points in the curve file are the same for a closed profile.

3. Click **Browse** from the Curve File dialog box.

4. **Browse** to the SolidWorks 2015 folder.

5. Set file type to **Text Files**.

6. Double-click **cam2.text**. View the data in the Curve File dialog box. View the sketch in the Graphics window. Review the data points in the dialog box.

7. Click **OK** from the Curve File dialog box. Curve1 is displayed in the FeatureManager. This curve can now be used in a sketch (fully defined profile). View the results of the fully defined sketch using the curve.

8. **Close** the model.

9. Open Curve Through XYZ points 4-2 from the SolidWorks 2015 folder to view the final model and FeatureManager.

10. **Close** the model.

💡 See Chapter 18 - Intelligence Modeling techniques for additional information.
Curve Through Reference Points

The Curve Through Reference Points tool provides the ability to create a curve through points located on one or more planes. See SolidWorks Help for additional information.

Point Sketch Entity

The Point Sketch entity tool provides the ability to insert points in your sketches and drawings. To modify the properties of a point, select the point in an active sketch, and edit the properties in the Point PropertyManager. The Point PropertyManager provides the following selections:

- **Existing Relations.** The Existing Relations box provides the following options:
  - **Relations.** Displays the automatic relations inferred during sketching or created manually with the Add Relations tool. The callout in the Graphics window is highlighted when you select a relation in the dialog box. The Information icon in the Existing Relations box displays the sketch status of the selected sketch entity.

- **Add Relations.** Provides the ability to add relations to the selected entity. Displays the relations which are possible for the selected entity.
Design Intent, Sketching and Sketch Entities

- **Parameters.** Provides the ability to specify the appropriate combination of parameters for your point only if the point is not constrained by relations. The available parameters are:
  - **X Coordinate.** Specifies the x coordinate of your point.
  - **Y Coordinate.** Specifies the y coordinate of your point.

**Centerline Sketch Entity**

The Centerline Sketch entity tool provides the ability to use centerlines to create symmetrical sketch elements and revolved features, or as construction geometry. The Centerline sketch entity uses the Insert Line PropertyManager. The Insert Line PropertyManager provides the following selections:

- **Orientation.** The Orientation box provides the following options:
  - **As sketched.** Sketch a line in any direction using the click and drag method. Using the click-click method, the As sketched option provides the ability to sketch a line in any direction, and to continue sketching other lines in any direction, until you double-click to end your process.
  - **Horizontal.** Sketch a horizontal line until you release your mouse pointer.
  - **Vertical.** Sketch a vertical line until you release your mouse pointer.
  - **Angle.** Sketch a line at an angle until you release your mouse pointer.

  The angle is created relative to the horizontal.

- **Options.** The Options box provides two line types. They are:
  - **For construction.** Selected by default. Converts the selected sketch entity to construction geometry.
  - **Infinite length.** Not selected by default. Creates a line of infinite length which you can later trim in the design process.
  - **Midpoint line.** Creates a line that is symmetrical from the midpoint of the line.

Use Construction geometry to assist in creating your sketch entities and geometry that are ultimately incorporated into the part. Construction geometry is ignored when the sketch is used to create a feature. Construction geometry uses the same line style as a centerline.
Text Sketch Entity

The Text Sketch entity tool provides the ability to sketch text on the face of a part and extrude or cut the text. Text can be inserted on any set of continuous curves or edges. This includes circles or profiles which consist of lines, arcs or splines.

💡 Convert the sketch entities to construction geometry if the curve is a sketch entity, or a set of sketch entities, and your sketch text is in the same sketch as the curve.

The Text sketch entity uses the Sketch Text PropertyManager. The Sketch Text PropertyManager provides the following selections:

- **Curves.** The Curves box provides the following options:
  - **Select Edges, Curves Segment.** Displays the selected curves, edges, sketches, or sketch segments.

- **Text.** The Text box provides the following options:
  - **Text.** Displays the entered text along the selected entity in the Graphics window. If you do not select an entity, the text is displayed horizontally starting at the origin.
  - **Bold Style.** Bold the selected text.
  - **Italic Style.** Italic the selected text.
  - **Rotate Style.** Rotate the selected text.
  - **Left Alignment.** Justify text to the left. Only available for text along an edge, curve or sketch segment.
  - **Center Alignment.** Justify text to the center. Only available for text along an edge, curve or sketch segment.
  - **Right Alignment.** Justify text to the right. Only available for text along an edge, curve or sketch segment.
  - **Full Justify Alignment.** Justify text. Only available for text along an edge, curve or sketch segment.
  - **Flip.** Provides the ability to flip the text.
• **Flip Vertical direction and back.** The Flip Vertical option is only available for text along an edge, curve or sketch segment.

• **Flip Horizontal direction and back.** The Flip Horizontal option is only available for text along an edge, curve or sketch segment.

• **Width Factor.** Provides the ability to widen each of your characters evenly by a specified percentage. Not available when you select the Use document's font option.

• **Spacing.** Provides the ability to modify the spacing between each character by a specified percentage. Not available when your text is fully justified or when you select the Use document's font option.

• **Use document's font.** Selected by default. Provides the ability to clear the initial font and to choose another font by using the Font option button.

• **Font.** Provides the ability to choose a font size and style from the Font dialog box.

**Tutorial: Text 4-1**

Apply text on a curved part. Use the Sketch Text tool.

1. Open **Text 4-1** from the SolidWorks 2015 folder. The Lens Cap is displayed in the Graphics window.

2. Click **Front Plane** from the FeatureManager.

3. Apply the Text Sketch tool.

4. Click inside the Text box.

5. Type **SolidWorks**. SolidWorks is displayed horizontally in the Graphics window starting at the origin, because you do not select an entity.

6. Click the **front edge** of Base Extrude. Edge<1> is displayed in the Curves option box. The SolidWorks text is displayed on the selected edge.

7. Uncheck the **Use document font** box.

8. Enter **250%** in the Spacing box.

9. Click the **Font** Button. The Choose Font dialog box is displayed.

10. Select **Arial Black, Regular, Point 14**.
11. Click **OK** from the Choose Font dialog box.

12. Click **OK** from the Sketch Text PropertyManager. Sketch7 is created and is displayed in the FeatureManager. Zoom in on the created text.

13. **Close** the model.

💡 If the curve is a sketch entity, or a set of sketch entities, and the sketch text is in the same sketch as the curve, convert the sketch entities to construction geometry.

### Plane Sketch Entity

The Plane Sketch entity tool provides the ability for the user to add Reference entities to a 3D sketch. Why? To facilitate sketching, and to add relations between sketch entities. Once you add the plane, you need to activate it to display its properties and to create a sketch. The Plane sketch entity uses the Sketch Plane PropertyManager.

The Sketch Plane PropertyManager provides the following selections:

- **First Reference.** Provides the ability to select Reference entities from the FeatureManager or from the Graphics window. Select the constraining relations to each reference. The available relations selection is based on the selected geometry.

- **Reference Entities.** Displays the selected sketch entity or plane as the reference to position the 3D Sketch plane.

- **Select a relation.** Select a relation based on the selected geometry.

💡 The available relations are displayed in the Sketch Plane PropertyManager under the First, Second and Third Reference. The relations are based on existing geometry.
• **Second Reference.** Provides the ability to select Reference entities from the FeatureManager or from the Graphics window. Select the constraining relations to each reference. The available relations selection is based on the selected geometry.

• **Reference Entities.** Displays the selected sketch entity or plane as the reference to position the 3D Sketch plane.

• **Select a relation.** Selects a relation based on the selected geometry.

• **Third Reference.** Provides the ability to select Reference entities from the FeatureManager or from the Graphics window. Select the constraining relations to each reference. The available relations selection is based on the selected geometry.

• **Reference Entities.** Displays the selected sketch entity or plane as the reference to position the 3D Sketch plane.

• **Select a relation.** Selects a relation based on the selected geometry.

With existing geometry, add a plane by referencing the entities that are present. Use any number of references required to achieve the desired results.

**Tutorial: Sketch Plane 4-1**

Add a 3D Sketch plane. Add a plane using references. Select two corner points of a 3D sketch. The corner points of the rectangle reference the position of the 3D sketch plane.

1. Open Sketch Plane 4-1 from the SolidWorks 2015 folder.

2. **Edit** 3DSketch1 from the FeatureManager.

3. Click **Tools** ▶ **Sketch Entities** ▶ **Plane.** The Sketch Plane PropertyManager is displayed.

💡 Rename a feature or sketch for clarity. Slowly click the feature or sketch name twice and enter the new name when the old one is highlighted.
4. Click the **top front corner point** of the rectangle as illustrated. Point3 is displayed in the First Reference box.

5. Click the **bottom back corner point** of the rectangle. Point4 is displayed in the Second Reference box.

6. Click **OK** from the Sketch Plane PropertyManager.

7. **Rebuild** the model. Plane2@3DSketch1 is created and is displayed in the Graphics window.

8. **Close** the model.

## Route Line Sketch Entity

The Route Line Sketch entity tool provides the ability to insert a Route line between faces, circular edges, straight edges, or planar faces. The Route Line Sketch entity is active when you:

- Create an Explode Line Sketch.
- Edit an Explode Line Sketch.
- Select the Route Line tool in a 3D sketch.

The Exploded Line Sketch tool is a 3D sketch added to an Exploded View in an assembly. The explode lines indicate the relationship between components in the assembly.

The Route Line Sketch entity uses the Route Line PropertyManager. The Route Line PropertyManager provides the following selections:

- **Items To Connect.** The Items To Connect box provides the following option:
  - **Reference entities.** Displays the selected circular edges, faces, straight edges or planar faces to connect with your created route line.

- **Options.** The Options box provides the following selections:
  - **Reverse.** Reverses the direction of your route line. A preview arrow is displayed in the direction of the route line.
  - **Alternate Path.** Displays an alternate possible path for the route line.
  - **Along XYZ.** Creates a path parallel to the X, Y and Z axis directions.
Clear the Along XYZ option to use the shortest route.

**Tutorial: Route Line 4-1**
Create an Explode Line sketch using the Route Line Sketch entity.

1. Open the Route Line 4-1 assembly from the SolidWorks 2015 folder. The assembly is displayed in an Exploded view.

2. Click the Explode Line Sketch tool from the Assembly toolbar. The Route Line PropertyManager is displayed.

3. Click the inside face of Cut-Extrude1 of Shaft-Collar<1>. The direction arrow points towards the back. If required, check the Reverse direction box. Face<1>@Shaft-Collar-1 is displayed in the Items To Connect box.

4. Click the inside face of the top hole of Cut-Extrude1 of the Flatbar<1> component. Face<2>@Flatbar-1 is displayed in the Items To Connect box. The arrow points towards the right.

5. Click the inside face of Cut-Extrude5 of RodClevis<1>. Face<3>@AirCylinder-1 is displayed in the Items To Connect box. The arrow points towards the back.

6. Click the inside face of the second Cut-Extrude5 feature of RodClevis<1>. Face<4>@AirCylinder-1 is displayed in the Items To Connect box.

7. Click the inside face of the top hole of Cut-Extrude1 of the Flatbar<2> component. Face<2>@Flatbar-2 is displayed in the Items To Connect box. The arrow points towards the back.
8. Click the **inside face** of Cut-Extrude1 of SHAFT-COLLAR<2>. The direction arrow points towards the back. Face<1> @Shaft-Collar<2> is displayed in the Items To Connect box.

9. Click **OK** from the Route Line PropertyManager. View the created Route Line.

10. Click **OK** from the PropertyManager to return to the FeatureManager.

    Fit the model to the Graphics window. Display an Isometric view.

11. Press the f key to fit the model to the Graphics window.

12. Click **Isometric view**. View the results.

13. **Close** the model.

    SolidWorks provides the ability to create a Bill of Materials (BOM) in an assembly. The BOM is displayed in the Tables folder of the FeatureManager. You no longer need to create a drawing to see a BOM. See the Assembly section for additional information.

**Tutorial: Route Line 4-2**

Edit an Explode Line Sketch.

1. Open **Route Line 4-2** from the SolidWorks 2015 folder. The Route Line 4-2 Assembly FeatureManager is displayed.

2. Click the **ConfigurationManager** tab.

3. **Expand** Default.

4. Right-click **ExplView1** from the ConfigurationManager.

5. Click **Explode**. View the results in the Graphics window.

6. **Expand** ExplView1.
Design Intent, Sketching and Sketch Entities

Edit the Explode Line Sketch.
7. Right-click 3DExplode1 from the ConfigurationManager.

8. Click Edit Sketch.

9. Display a Top view.

10. Click Centerline from the Sketch toolbar. The Insert Line PropertyManager is displayed.

11. Click the endpoints of the Route Line as illustrated.

Create a new path.
12. Click a point to the right of the Route Line endpoint and over the top of the axle.

13. Click a point below the axle as illustrated.

14. Click a point to the left of the axle over the Flatbar.

15. Click a point below the Flatbar.

16. Click a point above the SHAFT-COLLAR.

17. Click a point below the Shaft-Collar.

Deselect the active Sketch tool.
18. Right-click Select in the Graphics window.

19. Rebuild the model. View the results.

20. Return to the FeatureManager design tree.

21. Close the model.
Belt/Chain Sketch Entity

This option provides the ability to create layout sketches for pulleys or sprocket mechanisms. The Belt/Chain feature simulates a cable-pulley mechanism. The Belt/Chain entity uses the Belt/Chain PropertyManager.

In the past, it was difficult using SolidWorks to effectively model components such as cables, chains, and timing belts due to their flexible motion. The shapes of these items could change over time. This made it difficult to examine the way a belt would interact with two or more pulleys, or a cable system shifts a lever, or crank with a solid assembly model.

The Belt/Chain PropertyManager provides the following selections:

- **Belt Members.** The Belt Members box provides the following options:
  - **Pulley Components.** Displays the selected arcs or circles for the pulley components.
  - **Up arrow.** Moves the selected pulley component upwards in the displayed order.
  - **Down arrow.** Moves the selected pulley component downward in the displayed order.
  - **Flip belt side.** Changes the side on which the belt is located in the pulley system.

- **Properties.** The Properties box provides the ability to define the following belt conditions. They are:
  - **Driving.** Cleared by default. Provides the ability to calculate the length of your belt. When checked, enter a value if you do not want the system to calculate your belt length. Based on the constraints, one or more of the components may move to adjust for the length of the belt.
  - **Use belt thickness.** Specifies the thickness value of the belt.
Design Intent, Sketching and Sketch Entities

- **Engage belt.** Selected by default. Disengages the belt mechanism.

💡 Only circle entities in a block can be selected for a belt member.

**Blocks**

Blocks are a grouping of single or multiple sketch entities. In SolidWorks, the origin of the block is aligned to the orientation of the sketch entity. Previously, blocks inherited their origin location from the Parent sketch. Additional enhancements to Blocks are:

- Modeling pulleys and chain sprockets.
- Modeling cam mechanisms.

Blocks are used in the Belt/Chain sketch entity. You can create blocks from a single or multiple sketch entities.

Why should you use Blocks? Blocks enable you to:

- Create layout sketches using the minimum of dimensions and sketch relations.
- Freeze a subset of sketch entities in a sketch to control as a single entity.
- Manage complicated sketches.
- Edit all instances of a block simultaneously.

💡 Use blocks in drawings to conserve drawing items such as standard label positions, notes, etc. See SolidWorks Help for additional information.

**Blocks toolbar**

The Blocks toolbar controls blocks in sketching. The Blocks toolbar provides the following tools:

- **Make Block.** The Make Block 🔄 tool provides the ability to create a new block.

- **Edit Block.** The Edit Block 🔄 tool provides the ability to add or remove sketch entities and to modify dimensions and relations in your sketch.

- **Insert Block.** The Insert Block 🔄 tool provides the ability to add a new block to your sketch or drawing. This option provides the ability to either create multiple instances of existing blocks or to browse for existing blocks.
- **Add/Remove.** The Add/Remove tool provides the ability to add or remove sketch entities to or from your block.

- **Rebuild.** The Rebuild tool provides the ability to update the parent sketches affected by your block changes.

- **Saves Block.** The Saves Block tool provides the ability to save the block to a file. Adds an .sldblk extension.

- **Explode Block.** The Explode Block tool provides the ability to explode the selected block.

- **Belt/Chain.** The Belt/Chain tool provides the ability to insert a belt.

Exploding a single instance of the block, only affects that instance of the block.

**Tutorial: Block 4-1**

Create a Block using the Blocks toolbar.

1. Create a **New** part. Use the default ANSI Part template.

2. Click **Top Plane** from the FeatureManager. This is your Sketch plane.

3. Sketch a **closed sketch** using sketch entities as illustrated. The sketch consists of five lines.

4. Click **Make Block** from the Block toolbar or click **Tools > Blocks > Make.** The Make Block PropertyManager is displayed.

5. Box-select the **sketch entities** from the Graphics window. The selected sketch entities are displayed in the Block Entities box.

6. Click **OK** from the Make Block PropertyManager. Note the location of the insertion point. Block1-1 is displayed in the FeatureManager.

7. **Rebuild** the model.

8. **Close** the model.
Create a block for a single or combination of multiple Sketch entities. Saving each block individually provides you with extensive design flexibility.

**Tutorial: Belt-chain 4-1**

Use the Belt/Chain Sketch entity function. Create a pulley sketch.

1. Open **Belt-chain 4-1** from the SolidWorks 2015 folder. View the three created blocks in the Belt-chain FeatureManager.

2. Edit **Sketch1** from the FeatureManager.

3. Click **Tools > Sketch Entities > Belt/Chain**. The Belt/Chain PropertyManager is displayed.

4. Select the **three circles** from left to right. The select circles are displayed in the Belt Members dialog box.

5. Check the **Driving** box.

6. Enter **460mm** for Belt Length.

7. Check the **Use belt thickness** box.

8. Enter **20mm** for belt thickness.

9. Click **OK** from the Belt/Chain PropertyManager.

10. **Expand** Sketch1. Belt1 is created and is displayed in the FeatureManager. The calculated belt length was larger than the belt length entered in the PropertyManager. The system moved the entities to correct for the entered 460mm belt length.

11. **Rebuild** the model. View the results.

12. **Close** the model.

View SolidWorks Help for additional information.

The Select Chain command has been enhanced to allow you to select construction entities. See SolidWorks Help for additional information.
Reuse an existing 2D Sketch

You can use the same sketch to create different features. To create different features with the same sketch:

- Create a sketch.
- Create a feature from the sketch.
- In the FeatureManager design tree, select the same sketch used to create the first feature.
- Create a second feature from the sketch.

In the FeatureManager design tree, a sketch that is shared by multiple features is identified by the Shared icon or by Shared icon for a selected contour.

💡 Add additional sketches as required to create the features. For example; if one feature is an extrude and the other feature is a revolve, use the same sketch for both features, but add a centerline to create the revolve.

**Tutorial: Shared Sketch 4-1**

Create an Extrude Thin feature with a shared sketch.

1. Open **Shared Sketch 4-1** from the SolidWorks 2015 folder.
2. Click **Sketch1** from the FeatureManager. View the sketch in the Graphics window.
3. Click **Extruded Boss/Base** from the Feature toolbar.
4. Select **Mid Plane** for End Condition in Direction 1.
5. Enter **16.00mm** for Depth.
6. Check the **Thin Feature** dialog box.
7. Enter **4.50mm** for Thickness.
8. Click the **Reverse Direction** button.
9. Click inside the **Selected Contours** dialog box.
10. Click the **circumference of the large circle** in the Graphics window.
11. Click **OK** from the PropertyManager.
12. **Expand** Extrude-Thin1 in the FeatureManager. View the Shared sketch.

13. **Close** the model.

---

**Summary**

In this chapter, you learned about the available tools to incorporate Design Intent into a sketch, feature, part, assembly and drawing.

Sketching is the foundation of a model. You addressed 2D and 3D Sketching and how to recognize the various Sketch states: *Fully Defined, Over Defined, Under Defined, No Solution Found and Invalid Solution Found* along with identifying the correct Reference plane.

You reviewed the following Sketch Entities; Line, Corner Rectangle, Center Rectangle, 3 Point Corner Rectangle, 3 Point Center Rectangle, Parallelogram, Straight Slot, Centerpoint Straight Slot, 3 Point Arc Slot, Centerpoint Arc Slot, Polygon, Circle, Perimeter Circle, Centerpoint Arc, Tangent Arc, 3 Point Arc, Ellipse, Partial Ellipse, Parabola, Conic, Spline, Style Spline, Spline on Surface, Equation Driven Curve, Point, Centerline, Text, Plane, Route line and Belt/Chain.

You utilized and addressed the following toolbars; Block toolbar and Spline toolbar and applied the Instant3D tool.

Fully define all sketches in the model. However; there are times when this is not practical. Generally when using the spline tool to create a freeform shape.

Use Construction geometry to assist in creating your sketch entities and geometry that are ultimately incorporated into the part. Construction geometry is ignored when the sketch is used to create a feature. Construction geometry uses the same line style as a centerline.

💡 Press the Tab key to change planes in a 3D Sketch.
You can transition from sketching a line to sketching a Tangent Arc, and vice versa without selecting the Arc tool from the Sketch toolbar. Example: Create a line. Click the endpoint of the line. Move your mouse pointer away. The Preview displays another line. Move your mouse pointer back to the selected line endpoint. The Preview displays a tangent arc. Click to place the arc. Move the mouse pointer away from the arc endpoint. Perform the same procedure above to continue.

💡 Rename a feature or sketch for clarity. Slowly click the feature or sketch name twice and enter the new name when the old one is highlighted.

💡 The plane or face you select for the Base sketch determines the orientation of the part.

💡 The PropertyManager remembers its last used state.

In Chapter 5, explore and address the Sketch tools, 2D to 2D toolbar, Geometric Relations, Dimensions/Relations toolbar, the DimXpertManager and learn about TolAnalyst.